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ABSTRACT

The UCSC Genome Browser (https://genome.ucsc.
edu) is an omics data consolidator, graphical viewer,
and general bioinformatics resource that continues
to serve the community as it enters its 23rd year.
This year has seen an emphasis in clinical data, with
new tracks and an expanded Recommended Track
Sets feature on hg38 as well as the addition of a
single cell track group. SARS-CoV-2 continues to re-
main a focus, with regular annotation updates to the
browser and continued curation of our phylogenetic
sequence placing tool, hgPhyloPlace, whose tree has
now reached over 12M sequences. Our GenArk re-
source has also grown, offering over 2500 hubs and
a system for users to request any absent assem-
blies. We have expanded our bigBarChart display
type and created new ways to visualize data via bi-
gRmsk and dynseq display. Displaying custom anno-
tations is now easier due to our chromAlias system
which eliminates the requirement for renaming se-
quence names to the UCSC standard. Users involved
in data generation may also be interested in our new
tools and trackDb settings which facilitate the cre-
ation and display of their custom annotations.

INTRODUCTION

The University of California Santa Cruz (UCSC) Genome
Browser (1) is an online resource for the genomics com-
munity providing data access and visualization, collabora-
tion and support resources, and a suite of tools that are
now standard in the field. With the ever-increasing amounts

of data being generated every year, tools like the UCSC
Genome Browser and other browsers (2–6) are increasingly
playing a key step in analysis and interpretation. Our re-
source services over 1.4 million users per year across its pri-
mary site as well as its European and Asian based mirrors.
We also maintain near 100% uptime and continually update
our software on a tri-week cycle.

With regards to data access and visualization, we offer
over 6000 tracks on the two latest human GRCh assem-
blies alone, GRCh38/hg38 and GRCh37/hg19. There are
also over 200 assemblies available on the Genome Browser
and over 2000 if GenArk (7) is included. We support over 30
data formats such as bed/bigBed, wig/bigWig (8), VCF (9)
and GTF/GFF. This not only allows users to display their
own annotations, but also to visualize data from a large
number of sources in a single location. Nearly all data is
available for extraction via bulk download, public MySQL
server, RESTful API (10) or the Table Browser (11).

We also provide tools to facilitate scientific collaboration
as well as support for the community. Immutable snapshots
of annotations and locations can be shared via the sessions
feature (My Data → My Sessions), custom data can be
shared as custom tracks (My Data → Custom Tracks) and
hubs (My Data → Track hubs), and user-generated hubs
can be shared with the wider community by means of the
Public Hub list. We also respond to over 600 mailing list
questions per year, assisting users with topics such as how
best to display their data, troubleshooting our tools, and
generating chain files for lifting between assemblies.

Lastly, we provide and support many other tools and util-
ities. Some of the most popular tools not yet mentioned are
BLAT (12) for placing sequences, In-Silico PCR for iden-
tifying PCR primers, and LiftOver which provides a web
interface for converting genomic coordinates between as-
semblies. Our hundreds of utilities (https://hgdownload.soe.
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ucsc.edu/downloads.html#utilities downloads) can also be
downloaded. These include file format creation, such as
bedToBigBed, command line versions of our web tools such
as liftOver, and other resources. And for users that may have
sensitive data or poor connections, we offer various ways to
mirror our software locally (Mirrors → Mirroring Instruc-
tions). For more information on what the Genome Browser
has to offer, visit our training page (https://genome.ucsc.
edu/training).

NEW AND UPDATED ANNOTATIONS

Over the last year we have added and updated over 50 anno-
tation tracks to existing assemblies, added a new single-cell
annotation group to hg38, made seven new or updated Pub-
lic Hubs available, and added over 900 new assembly hubs
via GenArk. We have also created hundreds of liftOver files,
all of which are available on our download server, which al-
low coordinate lifting between assemblies. This includes 36
files directly requested by users on our mailing list.

New clinical data

Twelve new tracks have been added to human assemblies
in support of variant interpretation and clinical genomics.
Some notable examples include DECIPHER (DatabasE of
genomiC varIation and Phenotype in Humans using En-
sembl Resources) (13), which aggregates variant informa-
tion from various sources, added to hg38; Orphanet (14),
which provides comprehensive datasets related to rare dis-
eases and orphan drugs from the Orphanet knowledge base;
GenCC (The Gene Curation Coalition) (15), which aims
to collect and standardize gene-disease validity annotations
across various submitters; and dbSNP155 (16), which is the
latest NCBI dbSNP release with over one billion variants.
We have also continued to update our Microarray Probesets
tracks, which now contain the positions of probes and tar-
gets of over 50 NGS arrays. A new Constraint Scores track
is also available which hosts various mutation constraint an-
notations from different data providers. For a complete list
of new and updated clinical tracks see Supplementary Table
S1.

In order to better introduce the clinical resources avail-
able on hg38, we have expanded our Recommended Track
Sets (17) (https://genome.ucsc.edu/goldenPath/newsarch.
html#022222) feature to hg38 (Figure 1). Like hg19, this
feature contains 4 sets of curated track configurations for
different clinical applications.

New single-cell track group on hg38

We have added a new single-cell RNA-seq (scRNA-seq)
track group to hg38 (Figure 2). It currently contains
14 scRNA-seq tracks, originally wrangled into our Cell
Browser (https://cells.ucsc.edu) (18), covering major organs
of the body with each track being comprised of 2–19 indi-
vidual mRNA expression tracks in barChart format. There
are also two aggregate tracks: Tabula Sapiens (19), which
contains data from the Tabula Sapiens Consortium pro-
viding an atlas of nearly 500 000 cells from 24 organs of

15 normal humans, and a Merged Cells track, which is an
aggregate track created by the Genome Browser contain-
ing data from 12 papers covering 14 organs. A complete
list of new single-cell tracks is available in Supplementary
Table S2.

Gene set updates

This year we have added or updated 15 gene annota-
tions for human and mouse. We continue to provide
the latest GENCODE gene models (20), currently v41,
which are always available on hg38, hg19 and mm39.
We also archive these releases for reproducibility, hav-
ing added 38–41 during this period. The NCBI RefSeq
gene models (21) on hg38 and hg19 have also been up-
dated corresponding to NCBI release 109.20211119 and
105.20220307 respectively. We have also added the 1.0 re-
lease of the Matched Annotation from NCBI and EMBL-
EBI (MANE) project (22), which provides a set of high-
confidence transcripts that are identically annotated be-
tween RefSeq and Ensembl/GENCODE. Lastly, we have
updated select tables (kgXref, kgAlias) and our search files
for the default hg19 gene annotation track UCSC Genes
(knownGene) (23) so that new and updated gene symbols
can be found.

Other new tracks

In addition to clinical, single-cell and gene tracks, we have
added 8 new tracks to our vertebrate assemblies. These in-
clude a European Variation Archive (EVA) (24) track cor-
responding to EVA release 3 on 14 assemblies including
mm39, providing novel variant data on these Browsers.
There is also now a 241-way Cactus (25,26) comparative
genomics alignment track on hg38 generated by the Zoono-
mia Project (27), which is the largest conservation track in
the Genome Browser. We have also added various regu-
latory tracks and additional annotations from the GTEx
Consortium (28). See Supplementary Tables S2–S4 for a
full list of tracks and assemblies. We also continue to run
our pipelines which automatically update annotations on
13 tracks, which can be seen in Supplementary Table S5.

SARS-CoV-2 genome browser updates

We continue to regularly update our SARS-CoV-2 assem-
bly data, adding or updating 14 tracks over the last year.
Among these tracks is our Variants of Concern (VOC)
track, which we continue to update with the latest WHO-
designated variants of concern. For a full list of updated
tracks see Supplementary Table S4.

Curation has also been ongoing on the growing
phylogenetic tree which supports our tool for placing
SARS-CoV-2 sequences using UShER (29), hgPhyloPlace
(https://genome.ucsc.edu/cgi-bin/hgPhyloPlace). The tree
now contains over 12 million sequences, with updates
occurring daily. A minimized version of the tree is included
in the pangolin tool (30), used by public health departments
worldwide to assign lineages to new sequences. The full
tree including GISAID sequences cannot be redistributed

https://hgdownload.soe.ucsc.edu/downloads.html#utilities_downloads
https://genome.ucsc.edu/training
https://genome.ucsc.edu/goldenPath/newsarch.html#022222
https://cells.ucsc.edu
https://genome.ucsc.edu/cgi-bin/hgPhyloPlace
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Figure 1. Recommended Track Sets available for hg38 in the Genome Browser menu (Genome Browser → Recommended Track Sets).

Figure 2. Single-cell RNA-seq track group now available on hg38.

due to GISAID restrictions (www.gisaid.org), but we offer
download files for a public sequence tree with over 6 million
sequences (https://hgdownload.gi.ucsc.edu/goldenPath/
wuhCor1/UShER SARS-CoV-2/) (31). We have also
recently expanded hgPhyloPlace for use with monkeypox
(RefSeq NC 063383.1).

New hubs

This year we have added 7 new ‘Public hubs’, which are ex-
ternally hosted and maintained annotations available to our
users via the Track Data Hubs page (https://genome.ucsc.
edu/cgi-bin/hgHubConnect). We continue to accept sub-
missions from users looking to promote and share their

data. These new hubs include the 2022 update of the popu-
lar ReMap Regulatory Atlas hub (32), which contains tran-
scriptional regulator annotations on 6 model genomes, and
a 605 species Mammal and Bird alignment using the Cactus
aligner. For a full list see Supplemental Table S6.

NEW ASSEMBLY DATA

Over the last year we have updated the official patch se-
quences from the Genome Reference Consortium (GRC)
for hg38 and mm10. The GRCh38/hg38 assembly has been
updated to patch 13, and GRCm38/mm10 has been up-
dated to patch 6. These updates contain both fix sequences
and alternate haplotypes.

http://www.gisaid.org
https://hgdownload.gi.ucsc.edu/goldenPath/wuhCor1/UShER_SARS-CoV-2/
https://genome.ucsc.edu/cgi-bin/hgHubConnect
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Figure 3. Advanced options in Track Search now includes the option to search Public Hub tracks.

Genome Archive (GenArk)

With the continued drop in sequencing cost and increase in
assembly quality, we have expanded the resources spent on
rapid creation of browsers via assembly hubs based on Gen-
Bank (33) assembly accessions. This collection of in-house
generated hubs, referred to as Genome Archive (GenArk -
https://hgdownload.soe.ucsc.edu/hubs/), currently contains
2589 hubs. Over the last year alone we have added 904
new NCBI/VGP assemblies. There is now also a viral
genomes category (https://hgdownload.soe.ucsc.edu/hubs/
viral/index.html) containing 257 viral assemblies ready
for display. In response to user demand, we have cre-
ated an assembly request page (https://genome.ucsc.edu/
assemblyRequest.html). This page allows users to search
for most GenBank assemblies, currently containing 15 018
eligible browser candidates, and request a browser be cre-
ated if one does not already exist. New browsers are
typically ready in less than a week. For more informa-
tion on GenArk, see our detailed four-part blog series
on the topic (https://genome-blog.soe.ucsc.edu/blog/2021/
11/23/genark-hubs-part-1/).

T2T CHM13 v2.0 assembly (hs1)

Soon after the T2T consortium published their T2T
CHM13 v2.0 assembly (34), we created a GenArk browser
to display the sequence alongside various annotation tracks
which were a combination of consortium-generated and
in-house data. These include various gene annotations,
lifted clinical data, and comparative genomics tracks fo-
cused on the new sequence added in T2T CHM13 v2.0.
We expanded our hgConvert (https://genome.ucsc.edu/cgi-
bin/hgConvert?db=hg38) and hgLiftOver (https://genome.
ucsc.edu/cgi-bin/hgLiftOver?db=hg38) tools to support
GenArk assemblies in order to facilitate data conversion be-
tween hg19/hg38 and T2T CHM13 v2.0.

In anticipation of many high-quality genomes becoming
available in the near future, T2T CHM13 v2.0 was the first
human assembly to be elevated from hub to curated hub.
Curated hubs, while still hubs, have all the support of native
assemblies such as easier discovery and track search, API
support, and the ability to add custom annotations with-
out first having to connect to the hub. With this change to
curated hub the assembly name was changed to Homo sapi-
ens 1 (hs1). T2T CHM13 v2.0 (hs1) can be accessed directly
from the Genomes dropdown menu. It is worth noting that
to users curated hubs are functionally identical to native as-

semblies (e.g. hg19, hg38), and that in line with our repro-
ducibility practice, all previous hubs and hub data will con-
tinue to exist.

NEW GENOME BROWSER SOFTWARE

Over the last year we have expanded functionality of
the Genome Browser with small additions as well as
new and updated displays and settings. By user request,
we have added a comma separated values option to the
Table Browser output. The new setting can be toggled
on the ‘output field separator’ tab and facilitates data
download for use in other software such as excel. It is
now also possible to include Public Hub tracks in the
Track Search (https://genome.ucsc.edu/cgi-bin/hgTracks?
db=hg38&hgt tSearch=track+search) results by toggling
on the feature in the advanced options (Figure 3).

New displays

bigBarChart. Two new settings have been added to the
bigBarChart (https://genome.ucsc.edu/goldenPath/help/
barChart.html) format to allow for additional customiza-
tion of how the bars display: barChartBarMinWidth and
barChartBarMinPadding. There is also a new feature
for bigBarChart tracks that enables a facet display (Fig-
ure 4) in the item details page and track configuration
page (https://genome.ucsc.edu/cgi-bin/hgTrackUi?db=
hg38&c=chrX&g=tabulaSapiensTissueCellType). These
facets allow for visualization and grouping of complex
and expansive data, such as single cell data, into various
categories and granularities based on associated metadata.
The facets are enabled by adding the new trackDb settings
barChartFacets and barChartStatsUrl (https://genome.
ucsc.edu/goldenPath/help/barChart.html#example6).

bigRmsk. The bigRmsk track type (https://genome.ucsc.
edu/goldenPath/help/bigRmsk.html) has been added for
displaying repeat annotations generated by the Repeat-
Masker program. The setting is optimized for displaying re-
peat types, automatically changing its display based on the
window size. The track includes item coloring based on the
classification of the repeat, and the Full mode includes ad-
ditional details such as length of unaligned repeat model se-
quence and context for where a repeat fragment originates
(Figure 5A).

https://hgdownload.soe.ucsc.edu/hubs/
https://hgdownload.soe.ucsc.edu/hubs/viral/index.html
https://genome.ucsc.edu/assemblyRequest.html
https://genome-blog.soe.ucsc.edu/blog/2021/11/23/genark-hubs-part-1/
https://genome.ucsc.edu/cgi-bin/hgConvert?db=hg38
https://genome.ucsc.edu/cgi-bin/hgLiftOver?db=hg38
https://genome.ucsc.edu/cgi-bin/hgTracks?db=hg38&hgt_tSearch=track+search
https://genome.ucsc.edu/goldenPath/help/barChart.html
https://genome.ucsc.edu/cgi-bin/hgTrackUi?db=hg38&c=chrX&g=tabulaSapiensTissueCellType
https://genome.ucsc.edu/goldenPath/help/barChart.html#example6
https://genome.ucsc.edu/goldenPath/help/bigRmsk.html
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Figure 4. Search facets for bigBarChart track Tabula Sapiens: Tabula Tissue Cell.

Figure 5. (A) Full display mode in bigRmsk track. (B) dynseq display in full mode.

dynseq display. We have added support for the dynseq dis-
play (35) developed by the Kundaje lab (https://kundajelab.
github.io/dynseq-pages/). This display scales the height of
each nucleotide letter based on the signal value within
a bigWig track (https://genome.ucsc.edu/goldenPath/help/
bigWig.html#Ex4; Figure 5B).

New hub features and TrackDb statements

In order to facilitate custom annotations and user content,
we have expanded custom track as well as hub support

and added 15 new trackDb settings with various functions
(Table 1). When creating hub tracks for a genome that is in-
cluded in GenArk, you can now designate the GCA/GCF
identifier and the Genome Browser will automatically at-
tach the matching GenArk assembly hub genome and dis-
play the data on it (https://genome.ucsc.edu/FAQ/FAQlink.
html#genArkTrackHub). This harmonizes the system to
function like native assemblies, such as hg19 and hg38, and
removes the requirement of a multi-line genome stanza.
Another new feature that builds upon hub annotations
which are designated by the bigDataUrl setting is access

https://kundajelab.github.io/dynseq-pages/
https://genome.ucsc.edu/goldenPath/help/bigWig.html#Ex4;
https://genome.ucsc.edu/FAQ/FAQlink.html#genArkTrackHub
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Table 1. List of new trackDb settings added to the Hub Track Database Definition document (https://genome.ucsc.edu/goldenPath/help/trackDb/
trackDbHub.html) over the last year

Setting name Description

otherTwoBitUrl For in pairwise alignment tracks (chain, PSL), used to specify location of query sequence.
logo Enables the dynseq display feature on wiggle tracks.
speciesLabels Allows one to specify new labels that map to sequence names in bigMaf tracks.
hicDistanceMax Controls the maximum interaction distance in nucleotides for the heatmap in Hi-C tracks.
hicDistanceMin Controls the minimum interaction distance in nucleotides for the heatmap in Hi-C tracks.
barChartFacets Enables the facets feature in bigBarChart track description and item details pages.
barChartStatsUrl Associates a table in tab-separated-values with the bigBarChart track, with one line per bar.

Currently used in coordination with the barChartsFacets tag to specify metadata such as cell
types or tissue of origin.

barChartBarMinPadding Sets the minimum pixel width between bars for bigBarChart tracks.
barChartBarMinWidth Sets the minimum pixel width of the bars in bigBarChart tracks.
barChartStretchToItem Extends the barCharts to cover the entire horizontal space available in the graph. Useful for

bigBarChart tracks with many bars.
pslSequence Specifies display configuration options for PSL tracks that also have sequence loaded.
showCdsAllScales Shows CDS for PSL tracks at all zoom levels.
showCdsMaxZoom Specifies (bases/pixel) the maximum zoom-out allowed for displaying the CDS for PSL tracks.
showDiffBasesMaxZoom Shows annotations highlighting base or codon differences only if current zoom level does not

exceed value (bases/pixel) in PSL tracks.

to the extended case/color options. This means that when
browsing the tracks display while displaying hub data, you
can go to View → DNA in the top blue bar menu and
select the ‘extended case/color options’ button. In that
page you will be able to modify the DNA sequence in
the window in various ways depending on the data tracks
which are currently being displayed, such as adding a spe-
cific color for any part of the sequence covered by the
annotations.

chromAlias. The chromAlias system provides an index of
corresponding sequence names across different groups and
consortiums. An example would be how UCSC names chro-
mosomes with the ‘chr’ prefix while other groups such
as Ensembl (36) list only the number: ‘chr2’ in UCSC
corresponds to ‘2’ in Ensembl. In the past users would
have to modify the sequence names if they did not ad-
here to the UCSC convention, but that is no longer the
case. chromAlias associations have been built for all native
Genome Browsers as well as GenArk assemblies, looking
for corresponding matches in GenBank, Ensembl, and Ref-
Seq when available. When custom annotations are now at-
tached, if the sequence names do not match UCSC’s, then
the chromAlias table is referenced and displays the anno-
tations if a match is found. This support has also been
extended to the bedToBigBed utility, which now option-
ally accepts a chromAlias file instead of a chrom.sizes file
and will build the bigBed without any need for renam-
ing sequences. These chromAlias files can be found on our
download server, e.g. hg38 (https://hgdownload.soe.ucsc.
edu/goldenPath/hg38/bigZips/hg38.chromAlias.bb).

TrackDb settings

We added 15 new trackDb settings to our Hub Track
Database Definition document (https://genome.ucsc.
edu/goldenPath/help/trackDb/trackDbHub.html). These
include additional configurations for Hi-C track display,
bigBarChart display and PSL display among others. See
Table 1 for a full list and short description.

New and updated tools

We continue to add to and maintain our suite of over
300 command line tools (https://hgdownload.soe.ucsc.edu/
downloads.html#utilities downloads). Of notable mention
is our chromToUcsc tool, as well as four new tools which
help with data analysis and track creation. Many were
developed to assist in the creation of the new bigBar-
Chart single cell tracks. See our bigBarChart documenta-
tion for an example (https://genome.ucsc.edu/goldenPath/
help/barChart.html#example7).

chromToUcsc. Can be used to convert most standard an-
notation file formats (e.g. BED, wiggle, GTF, VCF, etc.)
that contain different sequence names to those expected by
UCSC, to the UCSC convention.

tabToTabDir. Takes a single large table and converts it to
a directory full of smaller tables. This is useful for exploring
and curating large metadata tables. It can be particularly
helpful in reducing a table with many fields into a few nor-
malized (in the relational sense) tables with fewer fields.

matrixClusterColumns. Converts a single cell gene expres-
sion matrix to a cell-type gene expression matrix. It takes a
cell-by-cell metadata matrix that refers to the same cells as
a gene expression matrix and combines the gene expression
values for all cells of a given type into a single value repre-
senting the cell type. It can also be used on other metadata
fields to produce matrices that show mean or average gene
expression levels for a donor, an organ, or any other meta-
data field or combination of fields.

gencodeVersionForGenes. Takes a list of gene symbols or
gene accessions and searches for the version of GENCODE
or RefSeq that matches the most genes in the list. Optionally
produces a bed file containing the gene structures for the
genes in the list.

matrixToBarChartBed. Combines an expression matrix
and a bed file with gene structures to make a bed file with a
bar chart showing gene expression on the Genome Browser.

https://genome.ucsc.edu/goldenPath/help/trackDb/trackDbHub.html
https://hgdownload.soe.ucsc.edu/goldenPath/hg38/bigZips/hg38.chromAlias.bb
https://genome.ucsc.edu/goldenPath/help/trackDb/trackDbHub.html
https://hgdownload.soe.ucsc.edu/downloads.html#utilities_downloads
https://genome.ucsc.edu/goldenPath/help/barChart.html#example7
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OUTREACH AND CONTACT INFORMATION

The Genome Browser supports users in a variety of ways
including a blog (https://genome.ucsc.edu/blog), videos
(https://bit.ly/ucscVideos), and both virtual and in-person
trainings (https://bit.ly/ucscTraining). In the year since the
last NAR update, we have conducted 25 workshops and
courses, including several at international meetings. Our
training page (https://genome.ucsc.edu/training) provides
access to these resources as well as an index to user guides
and help pages for all the Genome Browser tools. Three
new videos have also been added to the YouTube channel
(https://bit.ly/ucscVideos) featuring the use of the SARS-
CoV-2 browser.

We provide email support through a public and a pri-
vate mailing list where users can avail themselves of our
expert and responsive staff. Access to the mailing lists can
be found at https://genome.ucsc.edu/contacts.html, where
there is also a link to an archive of previously answered
questions from the public list.

In response to inquiries from our users, we released a
module of content designed for use in the undergraduate
classroom. This content features vignettes written by un-
dergraduates to illustrate, using the Genome Browser, a va-
riety of lessons in Molecular Biology, Genetics, Medicine,
Population Biology and Evolution. This can be found at
https://genome.ucsc.edu/training/education.

FUTURE PLANS

This coming year represents the first in our new 5-year plan-
ning cycle. A major goal during this time is evaluation and
adoption of a pangenome graph data format. We will also
be releasing a new site-wide search function and a track du-
plication feature. Work continues to expand hub support.
Most new data will be created in big formats and new assem-
blies will be implemented as hubs instead of SQL databases
(e.g. hs1). Along those lines, work will begin on a tool to
facilitate hub development. Lastly, an emphasis on clinical
genomics and single cell data will continue, with features
such as Recommended Track Sets and the new single cell
track group seeing updates throughout the year.

DATA AVAILABILITY

The UCSC Genome Browser (https://genome.ucsc.edu/) is
freely available to all users. The only exceptions are the
source code for the Genome Browser, Blat utility, liftOver
utility and other utilities which are free for non-profit aca-
demic research and for personal use. A license is required
for commercial use of these utilities or the source code.

SUPPLEMENTARY DATA

Supplementary Data are available at NAR Online.
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